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Q.1 Which country hosted the 2023 Men's Hockey World Cup?
Ans 5 1. Pakistan

#5 2.China
75 3. Germany
«” 4. India

Q.2 Kis the husband of S. B is the sister of T. Q is the daughter of E. T is the brother of E. S
is the mother of B. How is T related to K?

Ans < 1. Brother
X 2. Father
«” 3. Son
/5 4. Daughter

Q.3 If 15th and 28th terms of an A.P. be 208 and 416 respectively, then its 49th term is:
Ans X 1.755

X 2.749
o 3.752
X 4.751

Q.4 The full form of DDR SDRAM is

Ans X 1. Double Data Rate Systematic Dynamic Random Access Memory
/X 2. Dynamic Data Rate Systematic Dynamic Random Access Memory
4" 3. Double Data Rate Synchronous Dynamic Random Access Memory

#5 4. Data Dynamic Rate Synchronous Dynamic Random Access Memory

Q.5 Two parallel current-carrying conductors attract each other with a force of 3 N when
placed 2 cm apart. The currents in both conductors are initially the same, and the
length of the conductors is constant. If the currents in both conductors are doubled
and the distance between them is halved, what will be the new force?

Ans X 1.96N
o 2.24N
X 3. 12N
X 4.48N




Q.6 A tower stands vertically on the ground. From a point on the ground, 30 m away from
the foot of the tower, the angle of elevation of the top of the tower is 30°. What is the
height (in metres) of the tower?

Ans x 1. 3{}\{3
X2 1543
X3 2043

¥4 1043

Q.7 Which of the following orders is correct for the doping level in transistors?

Ans X 1. Emitter < base < collector
/X 2. Base < emitter < collector
#5 3. Collector < base < emitter

" 4. Base < collector < emitter

Q.8 The first and last terms of an A.P. are 20 and 55. If the sum of its terms is 600, then the
number of terms will be?

Ans K 1.15
2. 16
X 3.17
X 4.14

Q.9 Which of the following statements is correct about a transistor?

Ans #5 1. Emitter region is much thinner as compared to base and collector.
75 2. All the three regions emitter, base and collector have the same size.
25 3. Collector region is much thinner as compared to emitter and base.

" 4. Base region is much thinner as compared to emitter and collector.

Q.10 What will come in the place of the question mark ‘(?)’ in the following equation, if ‘+’
and ‘=’ are interchanged and ‘x’ and ‘+’ are interchanged?

15x5+7-8+9=7?
Ans K117

& 2.20

X 3.18

X 4.19

Q.11 Which of the following represents the applications used primarily for messaging and
communication?

Ans #5 1. Gmail and Firefox
¥ 2. WhatsApp and Telegram
#% 3. Safari and MS Word
5 4. Telegram and Safari

Q.12 Select the most appropriate options to fill in the blanks.
L.V.D.T. shows hysteresis and hence repeatability is under all conditions.

Ans X 1. high; excellent
«” 2. low; excellent
25 3. low; bad
X 4. high; bad




Q.13 Which type of virus is designed to attach itself to documents and spread through
macros in programs like Microsoft Word or Excel?

Ans X 1. Polymorphic Virus
< 2. Network Virus
X 3. Resident Virus

«" 4. Macro Virus

Q.14 In the following number-pairs, the second number is obtained by applying certain
mathematical operations to the first number. Which numbers should replace X and Y so
that the pattern followed by the two numbers on the left side of :: is same as that on the
right side of ::?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 — Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

X:40:60:Y
Ans X 1.X=32,Y=70
A 2. X=36, Y=68
" 3. X=32, Y=75
X 4.X=30,Y=75

Q.15 In the interim budget of the union government, what budget has been allocated for
Samagra Shiksha Abhiyan for the Financial Year 2024-25?

Ans X 1.%47,500 crore
X 2.%53,500 crore
/< 3.%40,200 crore
w* 4.337,500 crore

Q.16 If an event has odds in favour 4 : 5, then the probability that the event will NOT occur is:

Ans

1
w1 =
5

X2 2
5
u:?35
9
x4 I
9

Q.17 If the points A(1, 2), B(4, 3), C(1, 0) and D(k, -1) are the vertices of a parallelogram then,
the value of k is :

Ans K12
X 2.1
< 3.1
& 4.2




Q.18

Ans

In the following number-pairs, the second number is obtained by applying certain
mathematical operations to the first number. Which numbers should replace X and Y so
that the pattern followed by the two numbers on the left side of :: is same as that on the
right side of ::?

(NOTE : Operations should be performed on the whole numbers, without breaking
down the numbers into its constituent digits. E.g. 13 — Operations on 13 such as adding
Isubtracting /multiplying etc. to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

X:35::8:Y

X 1.X=10,Y=20
& 2.X=7,Y=48
X 3.X=3,Y=74
X 4.X=6,Y=68

Q.19

Ans

What should come in place of the question mark (?) in the given series?
1023 1024 1027 1032 1039 ?

X 1.1046

& 2.1048

/< 3.1045

X 4.1047

Q.20

Ans

Read the given statements and conclusions carefully. You have to take the given
statements to be true even if they seem to be at variance from commonly known facts.
You have to decide which conclusion/s logically follow/s from the given statements.

Statements:

All parks are grounds.

Some grounds are museums.
No museum is a theatre.

Conclusions:
(I) All museums are parks.
(Il) No ground is a theatre.

25 1. Only conclusion | follows.
w# 2. Neither conclusion | nor Il follows.
#5 3. Only conclusion Il follows.

#X 4. Both conclusions | and Il follow.

Q.21

Ans

Which of the following is true according to the work-energy theorem?

" 1. Work done on an object can either increase or decrease its kinetic energy
#5 2. The work done on an object is always positive
#5 3. Work done on an object always increases its kinetic energy

X 4. Kinetic energy is always conserved

Q.22

Ans

The direction of magnetic field lines inside a bar magnet is
#5 1. from North Pole to South Pole

#5 2. perpendicular to the magnetic axis
#5 3.random
" 4. from South Pole to North Pole

Q.23

Ans

The work done by non-conservative forces in a closed loop is

/5 1. always zero

X 2.independent of the path
" 3. dependent on the path
X 4. negative




Q.24 Which of the following is NOT an example of application software?

Ans «" 1. Windows Vista
X 2. Google Chrome
#5 3. Adobe Photoshop
5 4. WhatsApp
Q.25 In this question, a question is followed by two statements numbered (I) and (lIl). You
have to decide whether the data provided in the statements are sufficient to answer the
question. Read both the statements and decide the appropriate answer.
Question: Five people V, W, X, Y and Z are sitting in a straight row, facing north. Who
sits to the immediate left of Z?
Statement (l): Both V and X are immediate neighbours of Y. V sits at one of the extreme
ends of the row.
Statement (Il): Z sits to the immediate left of W. W sits at one of the extreme ends of the
row.
Ans /X 1. Data in either statement | alone or statement Il alone are sufficient to answer the question.
75 2. Data in statement Il alone is sufficient to answer the question while data in statement | is not.
w” 3. Data in statements | and |l together are sufficient to answer the question.
#% 4. Data in statement | alone is sufficient to answer the question while data in statement Il is not.
Q.26 In the equation x = A cos(wt+¢), where x is displacement, w is angular frequency, and ¢
is phase angle, the equation is dimensionally consistent if .
Ans 5 1. wt has dimensions of length and ¢ is dimensionless
5 2. A has dimensions of time and wt has dimensions of frequency
" 3. A has dimensions of length and wt is dimensionless
5 4. Ahas dimensions of length and ¢ has dimensions of time
Q.27 . . ;
Find the value of the given expression.
cosd sin®A .
+ — + 2sinA — cosA
1—tanA sinA — cosA
Ans &1 3sinA
X 2. sinA
X 3. 3cosA
X 4. cosA
Q.28 In which of the following cases will there be NO induced EMF in a coil?
Ans #5 1. The magnetic flux through the coil is changing.
" 2. The coil is moved parallel to the magnetic field lines.
#X 3. The coil is rotated in a magnetic field.
#X 4. The coil is moved perpendicular to the magnetic field lines.
Q.29 The mode and median of a data is 87.5 and 86, respectively. What is the mean of the
data? (Use empirical formula.)
Ans o 1.85.2
X 2.854
X 3.84.2

X 4.87.1




Q.30

Ans

Who inaugurated India’s first off-grid Green Hydrogen Plant in the Stainless Steel
Sector at Hisar in March 20247

X 1. HD Kumaraswamy

X 2. Amit Shah

#5 3. Bhupathiraju Srinivasa Varma
" 4. Jyotiraditya M Scindia

Q.31

Ans

When a conductor moves through a magnetic field, an induced current is produced.
The direction of the induced current is determined by

«" 1. Lenz's Law

/% 2. Faraday’s Law
#5 3. Coulomb's Law
X 4. Ampere’s Law

Q.32

Ans

If the quadratic equation x% - 4ax + (b + 1) =0, where a and b are real constants, has no
real roots, then:

X 1.b<(a+1)(a-1)
X 2.b<(2a+1)2a-1)
o 3.b>(2a+1)2a- 1)
K db>@+1)a-1)

Q.33

Ans

A car manufacturing company is sponsoring a basketball match by painting its logo on

the basketball at the rate of 3/ cm? . There are two identical basketballs of diameter 14
cm which are to be painted. What will be the total cost (in %) of painting the balls for the
company?

X 1.1848
X 2.3586
X 3.4928
& 4. 3696

Q.34

Ans

A statement is given followed by two arguments. Decide which of the arguments is/are
strong with respect to the statement.

Statement:

The Government of country B has urged its citizens to invest in rain water harvesting
and avail subsidies in doing so.

Arguments:

l. Ground water resources have been continuously depleting in country B.

Il. Country B experiences heavy rainfall during the monsoon season leading to flooding
in many low-lying areas.

#5 1. Both | and Il weaken the statement.
" 2. Both | and Il strengthen the statement.
#5 3. Il weakens while | strengthens the statement.

X 4.1 weakens while Il strengthens the statement.

Q.35

Ans

Which element is typically found at the bottom left of the desktop in the Windows OS?
75 1. Notification Center

«” 2. Start Menu
X 3. Recycle Bin
X 4. Quick Access Toolbar




Q.36

Ans

Select the most appropriate options to fill in the blanks.
Microprocessor 8085 has address line, hence it can access of the
memory.

X 1. 16; 32 kilobytes
5 2. 8; 32 kilobytes
75 3. 8; 64 kilobytes
¥ 4. 16; 64 kilobytes

Q.37

Ans

Dead time is the time required by an instrument to to respond to change in
quantity.

X 1. stop; output
/5 2. begin; output
" 3. begin; input

75 4. stop; input

Q.38

Ans

What is India’s average annual HDI growth for the period 1990-2019?
o 1.1.42
X 2.1.44

X 3.1.21
X 4.158

Q.39

Ans

LCDs typically have response times in the range of to , Whereas LEDs are
available with response times below

#5< 1.100 ms; 300 ms; 1000 ns
5 2.10 ms; 30 ms; 10 ns

25 3.10 ms; 30 ms; 100 ns
«" 4. 100 ms; 300 ms; 100 ns

Q.40

Ans

64 identical small spheres are cast from a sphere of radius 12 cm, with the total volume
of the small spheres being equal to the volume of the larger sphere. The diameter (in
cm) of each of the small spheres is:

o 1.6
X 2.1
X 3.5
X 4.3

Q.41

Ans

In which of the following devices are eddy currents utilised beneficially?
X 1. Electric heaters

25 2. Electric motors
#5 3. Transformer cores

" 4. Induction furnaces

Q.42

Ans

What does the 'This PC' icon on a Windows desktop represent?

5 1. An application launcher
25 2. Afile that stores system updates
w# 3. Access to drives, files and system properties

#5 4. Ashortcut to the Control Panel




Q.43 Which view is primarily used to run a slide show in MS-PowerPoint?
Ans | X 1.Notes Page View

X 2. Normal View
4" 3. Slide Show View
75 4. Slide Sorter View

Q.44 -
In APQR,3.LP=4.LQ=6LR, then find the value of(ZAP /_;Q+3£R).
Ans o 1.4409
X 2.30°
X370
X 4.650

Q.45 Study the given bar graph and answer the question that follows.

Students from Different Schools
Enrolled in Different Classes

French German Italian lapanese

Mumber of Students
%)
=

Classes
N 5choolA M SchoolB M 5choolC

The given bar graph shows the number of students from different schools enrolled in
different classes. Which class has the maximum students from school C?

Ans X 1. German
& 2. Italian
X 3. Japanese
X 4. French

Q.46 The product of (x - 9) and (x + 8) is:
Ans | X 1.x%+x+72

o 2. X2 -x-72

X 3.x2+72

X 4.x%+2x-72

Q.47 How do you sort data in Microsoft (MS) Excel in ascending or descending order?

Ans 5 1. By selecting 'Sort' from the Format menu
" 2. By selecting the data range, then choosing 'Sort' from the Data menu and specifying the sorting criteria and order
#5 3. By right-clicking on the data and selecting 'Sort' from the context menu
#% 4. By clicking on the 'Sort' button in the toolbar




Q.48 The band gap between conduction and valence band in metals is:

Ans o 1.0eV
K 2.6.0eV
X 3.0.7eV
K 411eV

Q.49 Refer to the following letter, number and symbol series and answer the question that
follows.

(Left) +2$Q=YLASSXL/%9T\=XH 6 ? (Right)

How many such numbers are there that are immediately preceded by a symbol and
immediately followed by a letter?

Ans & 1. Three
" 2. One
& 3. Two
5 4. Four

Q.50 The coordinates of the centroid of the triangle ABC whose vertices are A(-5, 7), B(-4, -5)

and C(4, 5), is
Ans 5 7
vi=33)
7 5
"erl=33)
4 7
"= 3)
3 7
Kelm3m3)

Q.51 The deflection sensitivity (s) of a CRT (cathode ray tube) is defined as:
(where D is deflection of the screen and E is defection voltage)

Ans 2
E

X2s=D XE
D

Xi3eg=, —
"V E
Wi g=—

Q.52 D,E,F G, H,I|, and J, each has an exam on a different day of a week starting from
Monday and ending on Sunday of the same week.
E has the exam on Friday. Only one person has the exam between E and D. J has the
exam on the day immediately after E. H has the exam on the day immediately after D.
Only two people have exams between H and G. F has the exam on the day immediately
before D. | does not have the exam on Monday.
How many people have exams between J and F?

Ans X 1.Five
5 2. Four
w# 3. Three
5 4. Two




Q.53

Ans

In an isosceles triangle, the vertex angle measures 76°. What is the measure of each of
the base angles?

% 1.32° and 49°
X 2.55° and 49°
o 3.52° and 52°
X 4.43° and 62°

Q.54

Ans

You can save your MS-PowerPoint presentation in the newest format , or as an
MS-PowerPoint 97-2003 Presentation .

25 1. (.docx), (.doc)
o 2. (.pptx), (.ppt)
& 3. (.odp), (-ppt)

& 4. (.ppt), (-pptx)

Q.55

Ans

36

2
The value of 13— 82 + (:) — 04 2x5 =

 1.28
X 2.27
X 3.37
X 4.38

Q.56

Ans

Which of the following factors does NOT affect the strength of the magnetic field inside
a solenoid?

#5 1. Number of turns per unit length
«” 2. Length of the solenoid
#X 3. Presence of a magnetic core

#X 4. Current flowing through the solenoid

Q.57

Ans

Which of the following terms will replace the question mark (?) in the given series to
make it logically complete?
LQ13 MR20 NS27 OT34 ?

X 1.PV41
X 2.Pva2
X 3.PU42
o 4. PU41

Q.58

Ans

How can you quickly change the case of selected text in MS Word?
«" 1. Use the keyboard shortcut ‘Shift + F3’

X 2. Right-click the selected text and choose ‘Font’
#5 3. Change it manually by typing the text again
75 4. Go to the ‘Home’ tab and click on ‘Change Case’

Q.59

Ans

Which of the following is the standard method to print a web page using most modern
web browsers?

w” 1. Pressing Ctrl + P (Windows) or Cmd + P (Mac)
X 2. Right-clicking and selecting 'Save As'

X 3. Pressing F12

X 4. Pressing Ctrl + S (Windows) or Cmd + S (Mac)




Q.60

Ans

Evaluate:

16
X1 3
19

17
X2 3-_
23

V3 328
33

_ 65
X4 33—
76

Q.61

Ans

Which of the following statements is true regarding the factors affecting the resistance
of a conductor?

«" 1. Resistance increases with an increase in the temperature for most metals.
X 2. Resistance is independent of the conductor's length.
X 3. Resistance is inversely proportional to the resistivity of the material.

/5 4. Resistance is directly proportional to the cross-sectional area of the conductor.

Q.62

Ans

Which of the following Articles of the Indian Constitution states that it is the duty of the
State to raise the level of nutrition and the standard of living of its people and to
improve public health?

5 1. Article 42
X 2. Article 44
75 3. Article 51
«” 4. Article 47

Q.63

Ans

In a survey of 350 students in a college, 150 students were found to be taking tea and
225 taking coffee, 100 were taking both tea and coffee. Find how many students were
taking neither tea nor coffee?

X 1.85
X 2.65
o 3.75
X 4.55

Q.64

Ans

Which of the following are copper deposits fields in India?

#5 1. Singareni and Singrauli
#X 2. Pench and Kanhan

#X 3. Jharia and Raniganj
" 4. Khetri and Kolihan

Q.65

Ans

IFA={3,57,9 11}, B={7,9, 11,13}, C = {11, 13, 15}, find AN (B U C).
& 1.{7,9, 11}
X 2.{3,5,7,9, 11}
X 3.{5,7,9, 11}
X 4.{3,7,9, 11}




Q.66 Intel 8051 microcontroller is a/an:
Ans 5 1. 64-bit microcontroller
25 2. 16-bit microcontroller
25 3. 24-bit microcontroller
# 4. 8-bit microcontroller
Q.67 QeEMO&SLILLL NM&anS&EE6T M MILD (LNLY.6 8 eM6T HeU6TIONS LIS S,
QEMOSSULLL (L6 &6rle agl & s saner NerUbHmSHms!
CTEOTLIEM S (L0196 Q& LI MBS 6IT.
1M & 60 & & 6iT:
'@ et e LysmEFmeoT & Flw eerfl O (&HS HITET, eTeorGou &L M&em T uUlle
&memev 2 eooremeu FmULL Bl @ WYetreor Bhiss 6T 9 emeureu(hld LIMTTES
alBLIW SEHRISTLAWSSHMGF QFUGCAITID' - R(H SHNS &6l
GLHMSHELLD FomeoTTT.
W96 BT
(i) emeTs 51 GO DL FMMIVTESEHLD LNrsmEnmer @iflw el NEGHS
BIL&6M6 GG G LIS LILL Ceusvor(®LD.
(i) 1MW 6L S|(HMISTLFW SHMEIS6T GL0Hen S &6 6r &euails G W&aln
LweorerfliLIeney 9168 FLOWILD G6LY 8608 WITEITEM6U WD S, (SLD.
Ans o 1. WUe (I) el (1) A& W ersiad LeTLmmallevemey
X 2. rue] (II) LLGWL WeTuH S DS
X 3. rye () LLOWL WeaTuH IS DS
X 4. W19e|&6T (1) nmmib (1) @ resor(LD L9 6dT LM /M) 6T meor
Q.68 A thermometer consistently reads 2°C higher than the actual temperature. This
thermometer is
Ans «” 1. precise but not accurate
#5 2. neither accurate nor precise
#5 3. accurate but not precise
X 4. both accurate and precise
Q.69 What is the name of the service unveiled by Reliance Jio Infocomm Limited, India's first
satellite-based gigabit broadband service, in October 2023?
Ans #5 1. Jio Fiber Network
/5 2. Digital Subscriber Lines
«” 3. Jio Space Fiber
X 4. Mobile Broadband
Q.70 What does the 'IF' function do in MS-Excel?
Ans 25 1. It sorts the data.
#5 2. It sums up the data.
" 3. It checks a condition and returns one value if true and another if false.
X 4. Itfilters the data.
Q.71 The induced potential difference in a conductor is directly proportional to
Ans #5 1. the area of the conductor

X 2. the resistance of the conductor
" 3. the speed of the conductor's motion through the magnetic field

X 4. the temperature of the conductor




Q.72 What will happen to the power consumed by a device if the current flowing through it is
doubled while the resistance remains constant?
Ans X 1. Power will double.
«* 2. Power will quadruple.
5 3. Power will remain the same.
X 4. Power will decrease.
Q.73 Which of the following is true for resistors in parallel?
Ans #X 1. The equivalent resistance is greater than the smallest resistance.
#X 2. The equivalent resistance is the sum of all resistances.
X 3. They have the same current.
«” 4. They have the same voltage.
Q.74 Three resistors have the following magnitudes.
R1=30 Q * 5%, R2 =60Q * 5%, R3 = 50Q * 5%
Determine the magnitude of limiting resultant resistance when all three resistances are
connected in series.
Ans W 1.140£7Q
A 2.140 £ 15Q
& 3.27.27 £15Q
X 4.2727+7Q
Q.75 When printing a web page, what is the '"Margins' setting control?
Ans «” 1. The space between the content and the edges of the printed page
5 2. The number of pages the content will span
#5 3. The color scheme of the web page
75 4. The font size of the content
Q.76 What is term used to refer the ‘exports to foreigners’ in the circular flow of income
diagram?
Ans «” 1. injection
X 2. Investment
5 3. expenditure
X 4. leakage
Q.77 A device operates with a current of 2 A and a voltage of 12 V. What is the energy
consumed in 5 minutes?
Ans | X 1.1440J
& 2.7200 J
X 3.14400 J
X 4.720J
Q.78 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which pair DOES NOT belong to that
?Jg:eg?The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster pair.)
Ans o 1. OH-MT
2. SL-RX
X 3.RK-QW

X 4.LEKQ




Q.79 The Deflection Factor (G) of a CRT (where s is the defection sensitivity) is defined as:

Ans | 1
K1.G6=—
g2
1
&2.G=—
5
X 3.G=¢?
X 4.G=s
Q.80 - . . 3 -
The probability that a student passes a Mathematics test is " and the probability
that he passes both the Mathematics and a Physics test is E. The probability that he
passes at least one test is Z. What is the probability that he passes the Physics test?
Ans 5
X1 —
36
W2 4
9
7
X3 =
9
5
K4
9
Q.81 Eddy currents are produced in a conductor when it is subjected to
Ans " 1. a changing magnetic field
X 2. a uniform magnetic field
/X 3. a constant magnetic field
75 4. an electrostatic field
Q.82 There are two types of links supported in the NTFS file system,
Ans 25 1. soft links and direct linking
5 2. hard links and direct linking
" 3. hard links and junctions
25 4. soft links and junctions
Q.83 Which of the following keyboard shortcuts is NOT used in MS Word 2019 to manipulate
the formatting of selected text?
Ans X 1.Ctrl+U
o 2.Ctrl+S
X 3.Ctrl +1
A 4.Ctrl+B
Q.84 What happens when you click the 'Font Color' button in the Home tab of MS-Word?
Ans #5 1. It changes the font color of the selected text to the default color.

#X 2. It changes the background color of the selected text.
X 3. It opens the Font dialog box.

¥ 4. It opens a drop-down list of colors to choose from.




Q.85 The Sl unit for measuring very large distances, such as astronomical distances, is

Ans X 1. metre
< 2. kilometre
/5 3. astronomical unit

«* 4. light-year

Q.86 Which of the following methods is used to create a custom series in MS-Excel?
Ans #X 1. Using Data Validation

75 2. Using Conditional Formatting
25 3. Using Sort & Filter
«# 4. Using the Fill Handle and dragging

Q.87 Yedreu(peuctToumnev HFLOEFTEVGTLD 6THI?
Ans X 1. GO& NSO

o 2. UB6UG Geong

X 3. F@hseur

X 4. 2TS5FTEVETID

Q.88

The value of 3% — 52 + (ﬁ)z— 8 + 0x9 —
13
Ans K 1.-3 -
X 2.5
X 3.4 ‘
42

Q.89 Which of the following statements is FALSE with ;'espect to Style Set in Outlook for
writing an email?

Ans 5 1. You can change the colors or fonts that are used in a Style Set by clicking Change Styles in the Styles group, and then
clicking Colors or Fonts.

5 2. If you changed the styles in a message and the styles are not updating the way you expected, click the Styles Dialog Box

Launcher, and then click the Style Inspector button (located at the bottom of the pane) to find out whether text was manually
formatted instead of formatted by using styles.

#5 3. You can see how a Quick Style set will look in a message by pointing to a Style Set without clicking it.

«" 4. After you select a Style, you can see a list of the style sets available within the styles. In the Styles group, click the Styles
Dialog Box Launcher .

Q.90 Which type of virus attaches itself to executable files and spreads when the file is run?
Ans #5 1. Macro Virus

X 2. Polymorphic Virus
#X 3. Boot Sector Virus

" 4. File Infector Virus

Q.91 Which of the following is NOT a disadvantage of LAN?

Ans X 1. It can face security issues if the central server is not properly secured.
" 2. It has high data transmission rates.
#5 3. It has a high initial setup cost.

X 4. It restricts the size of the network.




Q.92

Ans

Select the most appropriate option to fill in the blank.
Intel 8051 microcontroller has internal RAM.

25 1. 64-byte
o 2. 128-byte
X 3.32-byte
X 4. 16-byte

Q.93

Ans

A particle starts from rest and accelerates uniformly along a straight line with
acceleration a. After a time t, its velocity is v. If the particle continues to accelerate for
the next 2t, what will be the ratio of the distance travelled in the first t seconds to that in
the next 2t seconds?

& 1.1:8
X 2.1:12
K 3.1:6
X 4.1:4

Q.94

Ans

Dimensional consistency of an equation implies that

X 1. the equation is correct in all circumstances
«” 2. the equation respects the principles of homogeneity of dimensions
/5 3. the physical quantities involved are related correctly

/5 4. the units of measurement can be easily converted

Q.95

Ans

Which property of the material of a conductor determines its resistivity?
X 1. Melting point

" 2. Electrical conductivity
X 3. Temperature coefficient

X 4. Density

Q.96

Ans

The work done by a variable force is given by which of the following?
25 1. W=F-cosf
& 2. W=Fd
o« 3. W=[F dx

1
X4.W=Em2

Q.97

Ans

In which year was Pitt’s India Act passed by the British Parliament?
o 1.1784

X 2.1857
X 3.1774
X 4.1853

Q.98

Ans

In the following triad, each group of letters is related to the subsequent one following a
certain logic. Select from the given options, the one that follows the same logic.

LIVE - IVLE - EVIL
REST - ESRT - TSER

25 1. WIND - INWD - INDW

X 2. WEST - WSET - TSEW
" 3. MUTE - UTME - ETUM
< 4. YORK - OYRK - KORY




than diode voltage, then the brightness of the LED is approximately constant.
Ans X 1. temperature; smaller
/5 2.temperature; greater
& 3. current; greater

#5 4. current; smaller

Q.99 The brightness of LED depends upon ; when source voltage is much

Q.100 Select the most appropriate options to fill in the blanks.
are used in load cells and proving rings to measure produced.

Ans #% 1. Linear Variable Differential Transformer (LVDT); strain by the force
«” 2. Strain gauges; force by the strain
#5 3. Capacitive transducers; force by the strain

/X 4. Piezoelectric transducers; strain by the force
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